Copyright 2007 Corel Corporation. All rights reserved.

Corel MediaOne Reviewer's Guide

Protected by U.S. Patents 5652880; 5347620; 5767860; 6195100; 6385336; 6552725; 6657739; 6731309; 6825859; 6633305; Patents Pending.

Product specifications, pricing, packaging, technical support and information ("specifications") refer to the retail English version only. The specifications for all other versions (including other language versions) may vary.

INFORMATION IS PROVIDED BY COREL ON AN “AS IS” BASIS, WITHOUT ANY OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY QUALITY, SATISFACTORY QUALITY, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, OR THOSE ARISING BY LAW, STATUTE, USAGE OF TRADE, COURSE OF DEALING OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS OF THE INFORMATION PROVIDED OR ITS USE IS ASSUMED BY YOU. COREL SHALL HAVE NO LIABILITY TO YOU OR ANY OTHER PERSON OR ENTITY FOR ANY INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, LOST OR DAMAGED DATA OR OTHER COMMERCIAL OR ECONOMIC LOSS, EVEN IF COREL HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR THEY ARE FORESEEABLE. COREL IS ALSO NOT LIABLE FOR ANY CLAIMS MADE BY ANY THIRD PARTY. COREL'S MAXIMUM AGGREGATE LIABILITY TO YOU SHALL NOT EXCEED THE COSTS PAID BY YOU TO PURCHASE THE MATERIALS. SOME STATES/COUNTRIES DO NOT ALLOW EXCLUSIONS OR LIMITATIONS OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

Corel, the Corel logo, CorelDRAW, MAIL, Painter, Paint Shop Pro, Picture Tubes, PhotoSafe, WinZip, and WordPerfect are trademarks or registered trademarks of Corel Corporation and/or its subsidiaries in Canada, the U.S., and/or other countries.

Microsoft, DirectX, Outlook, and Windows are registered trademarks of Microsoft Corporation in the United States and/or other countries. QuickTime and the QuickTime logo are trademarks used under license. The QuickTime logo is a registered trademark of Apple Computer, Inc. in the United States and other countries. Other product, font, and company names and logos may be trademarks or registered trademarks of their respective companies.
## Contents

1 | Introducing Corel MediaOne Starter and Corel MediaOne Plus .....................................................1
   Fast, Fun, and Easy Photo and Video Software...........................................................................1
   Customer Feedback Guiding Development Priorities..........................................................1

2 | One Customer’s Story ..............................................................................................................3

3 | Key Features of Corel MediaOne Starter and Corel MediaOne Plus ........................................7
   Simplified Environment...........................................................................................................7
   Downloading and Organizing Photos and Videos ...................................................................8
   Editing and Enhancing Photos ..............................................................................................10
   Editing Videos......................................................................................................................14
   Creating Projects with Photos and Videos ..........................................................................15
   Sharing Photos and Videos ...................................................................................................18
   Protecting Photos and Videos .............................................................................................20

4 | What’s Included? ..................................................................................................................23
   Corel MediaOne Versions .....................................................................................................23
   System Requirements ........................................................................................................23
   Customer Support and Other Resources ..........................................................................24
   Corel MediaOne Version Comparison ..............................................................................25

5 | About Corel Corporation ..................................................................................................27
Introducing Corel® MediaOne™ Starter and Corel® MediaOne™ Plus

The Corel Product Management team listened closely to our customers to better understand what mattered to them, and the answer was clear — digital imaging software that is simple, flexible, and fun. They also wanted more opportunities to be creative with projects and templates that enable them to do more with their favorite photos and videos.

Fast, Fun, and Easy Photo and Video Software

Corel® MediaOne™ is fast, fun, and easy photo and video software that reflects Corel's ongoing engagement with our customers. As more and more people use their digital cameras to capture photos and videos, we recognized it was necessary to extend the capabilities of Corel Snapfire — our entry-level digital imaging product — to more accurately reflect the evolving multimedia needs of today's consumers.

With Corel MediaOne Starter, users can easily enhance and expertly combine their favorite photos and videos into entertaining slide shows. Corel MediaOne Plus users can even add music files and exciting motion effects to slide shows. Corel MediaOne Plus also offers more advanced photo- and video-editing features, DVD-authoring capabilities, an increased selection of project templates, and more protection options. In addition, Corel MediaOne Plus provides an expanded collection of creative templates, featuring new designs from Smilebox™ and Sandra Magsamen, award-winning author of Living Artfully.

Customer Feedback Guiding Development Priorities

Corel has worked in partnership with our customers, observing their use of Corel Snapfire and responding with continuous product updates and improvements. Our goal is to deliver engaging and rewarding experiences to our users with software that helps them achieve results that they are proud to share with family and friends. This dialogue with customers guided our development focus and, as a result, we prioritized the following items:

• improving application speed and performance
• making tasks easier to accomplish
• giving users more creative and fun options
• providing users with hassle-free backup and protection for their photos
**Improving application speed and performance**

As personal photo and video libraries continue to grow, people need software that can help them effectively manage and organize life’s moments. With Corel MediaOne, we focused on improving the overall performance of the application, including startup time, so that our customers can quickly and easily find and enhance their favorite photos and videos.

**Making tasks easier to accomplish**

Our goal is to make simple, flexible, and fun software that allows people to accomplish more with fewer clicks. With Corel MediaOne, we’ve reduced the number of clicks required to accomplish key tasks so that users can spend more time being creative and less time clicking through menu items. In addition, several features have been introduced that help users find and organize their photos and videos.

**Giving customers more creative and fun options**

More and more of our customers view photos and videos as a way to put their personal imprint on creative expression. Corel MediaOne Plus offers hundreds of templates in a wide range of styles to help customers enhance their photos. In addition, Corel has partnered with Smilebox and Sandra Magsamen to add dozens of new creative project templates.

In response to customer requests, we’ve also included many new frames, edges, and Picture Tubes™. Since customers have also expressed a desire to create DVD keepsakes of their slide shows and videos, Corel MediaOne Plus provides DVD-authoring capabilities, which include professionally-designed menus that help customers make their DVD creations both stylish and accessible.

**Protecting photos and videos**

As hard-disk storage replaces traditional photo albums, customers are increasingly conscious of protecting and preserving their personal memories. Without notice, virus attacks and hardware failures can wipe out digital memories. Corel is proud to partner with Sharpcast — the acclaimed online storage service — to provide customers with maximum protection and peace of mind. Corel MediaOne Plus makes the protection of digital memories virtually effortless. Customers can automatically back up photos and videos to Sharpcast’s online storage site, making it easy to preserve and share favorite memories online.
One Customer’s Story

Do you ever get the sense that you’ve outgrown the software that came with your digital camera? Or perhaps you find yourself marveling at a slide show or photo project and wondering why your efforts aren’t getting similar reactions? Don’t get me wrong — my friends and family all seem to enjoy the various slide shows, greeting cards, and photos that I occasionally e-mail around. It’s just that lately I’ve been feeling like there’s more that I can do creatively.
If you’re anything like me, your camera sometimes feels like a fashion accessory. Not that it matches any of my outfits, mind you. But it has become a constant companion and is with me on family outings, vacations, birthday parties, and celebrations. Not to mention the kids’ hectic, weekly schedule of parties, sporting events, music recitals, school plays, and just about anything else they’re involved with.

The flexibility is what I love most about digital photography. I can snap away to my heart’s content without worrying about the cost of developing photos that don’t turn out. I usually enjoy sifting through the results, picking out the best photos, retouching them, and adding my own creative flair to make something memorable out of life’s moments. Sometimes, though, the sifting gets rather tedious, especially after hubby’s been using the camera. He tends to take pictures only of the dog. Lots of pictures of the dog. I suppose he’s more comfortable not having to coax a smile out of ol’ Bowser — but I digress.

It was a complete surprise. I’d gone to the door to call the kids for dinner, just as my sister was letting go of my daughter’s bike seat. And there she was, riding along, all alone — powered by her own balance, force, and will — proudly shouting, “Mommy, mommy, look at me go!” As luck would have it, my trusty camera was sitting right there on a table in the foyer. And just like that, a priceless moment was captured forever.

Until recently, I would have been pulling my hair out for an easy way to share this screen gem with our technology-challenged parents. But something showed up in my inbox the other day that has really empowered my creative aspirations. It was a file called a Corel Show, sent by an old high-school pal, as encouragement to get the whole gang excited for our school’s upcoming 25th reunion.

At first, I was somewhat hesitant because I’d have to download some software just to view this Corel Show. But her message was intriguing, and she even warned that once you experiment with Corel MediaOne Starter, you’ll soon want to upgrade to Corel MediaOne Plus. So curiosity won out. I downloaded the software, started the Corel Show, and was immediately impressed and inspired.

My mind was flooded with ideas for personalized crafts, greeting cards, photo albums, collages, and so much more. Corel MediaOne even works with those long-neglected video clips. I was so enamored that I decided not to wait for my free, 30-day trial to expire, and I immediately paid the $30 upgrade fee. Besides, it was much cheaper than I expected, and I know it will be money well spent.

Have I mentioned that my penchant for picture-taking has made me the “official chronicler” for my entire family? I’m the one who rounds up the revelers at celebrations to snap a few pictures. At weddings and anniversary parties, I’m the one who runs around asking people to record those special video greetings to the happy couple.
Some of my camera-shy nieces and nephews have even taken to calling me “Aunt Paparazzi.”

My sister got married last year, and Corel MediaOne compelled me to finally do something with that day’s photos and video clips. So I used MediaOne to instantly find all the photos and videos from the wedding day. I picked the best ones, created a wonderful Corel Show, and get this — I used MediaOne to burn the show to DVD. That way, my sister and brother-in-law can view it over and over again on their new high-definition television. I haven’t put it in the mail just yet, but I’m sure they’ll be delighted.

Using this software was so incredibly easy that I knew my parents would be able to handle it. In fact, I whipped up a neat little Corel Show of my daughter’s first two-wheeled bike ride and e-mailed it to them, along with instructions for downloading Corel MediaOne. Of course, that led to a long-distance distress call, but after some guidance and gentle prodding they were quickly up-and-running — and tickled pink to see their granddaughter pedaling away.

Dad says Mom’s been hosting her weekly tea parties around the computer ever since, so that she can share my Corel Shows and other photo creations with her friends. I usually send both our parents anything I’ve made that’s kid-related: from thank-you cards and invitations to photo collages and slide shows. They can’t get enough of their growing grandchildren and it helps bridge the distance between us.

Katie had a birthday party last week, so I created personalized thank-you cards for her guests. Nothing extravagant — just a picture of her with her toothless grin blowing out the candles on her cake. I added a few decorative effects, like butterflies, a border, and a thank-you message. All in all, it took only minutes to create but I know her friend’s parents appreciate it. A couple of them have asked for my secret. “No secret,” I say, “just my camera and Corel MediaOne.”

My son Johnny’s little-league season just wrapped up, and he’s been bummed out about not winning in the playoffs. To lift the little guy’s spirits, I used MediaOne to find all the pictures taken during the season. I picked out the best, most action-packed shots, and then created a photo collage. With Corel MediaOne, I just dragged the photos onto the template, and voilà. Then, I printed it off in full color and pinned it up on his bedroom door. You should have seen his face light up when he saw himself in uniform, running, sliding, throwing, jumping, catching, and hitting.

Creating photo projects is so fast and simple that I’ve started using MediaOne to get things done around the house. I’ve been after hubby to get moving on renovating our master bathroom but he hates shopping, especially in the summer. So I took my camera along to visit some suppliers, gathering cost estimates and photographing samples of materials for the cabinetry and porcelain. Then I used MediaOne to tag the photos as “bathroom project” so that he could sit in front of the computer, easily pull up those pictures, and finally make some decisions. And I wouldn’t have to listen to him whine about missing his Sunday golf game.

One of my many favorite things about Corel MediaOne is its online backup service. Each time I download new pictures from my camera or memory card, MediaOne automatically sends the new files to a safe online storage site. This convenient option means that I never have to worry about backing up our precious digital images, something I wasn’t particularly diligent about anyway.

Thanks to Corel MediaOne, I can finally get around to some of the photo album projects I’ve been planning. I’ve got years and years of family vacations, celebrations, activities, and other goofy photos and video clips to catch up on. And I can’t wait to see all my old friends at our high school reunion — especially Sherry. She’s the one who sent me that first Corel Show, and I want to thank her for helping to free my creative spirit. With the multitude of options and project templates in Corel MediaOne, I know that I’ve just barely scratched the surface of seeing what I can do with my digital photos and videos.
Key Features of Corel® MediaOne™ and Corel® MediaOne™ Plus

Corel MediaOne lets digital camera users express their creativity while organizing, editing, sharing, and protecting their photos and videos. It includes automatic fixes, easy-to-use photo retouching tools, effortless organization features, and an online back-up system to keep those precious digital images safe.

Simplified Environment

Redesigned for ease of use, the Corel MediaOne interface includes a left-hand panel that divides the application's features into four main categories: Home, Enhance, Show, and Create.

The Home category includes tools and controls that make it easy to share, organize, adjust, and protect photos. The Enhance category provides additional photo-adjustment features, effects, and text tools. The Show category lets users put their photos and videos front and center by including them in Corel Shows, which are perfect for sharing with friends and family. The Create category lets users drag photos onto any one of the hundreds of creative project templates.

The Corel MediaOne interface lets users perform common photo-editing tasks with fewer clicks.
Message Center

Located in the lower-left section of the Corel MediaOne workspace, the Message Center is a helpful resource that delivers quick tips, photo ideas, and inspirational tutorials, as well as product news and special offers.

The Message Center provides quick tips, photo ideas, tutorials, product news, and special offers.

Downloading and Organizing Photos and Videos

Corel MediaOne includes the Corel Photo Downloader, which is the quickest and easiest way to transfer photos and videos from a digital camera to a computer. Corel MediaOne makes it easy for users to choose how to browse and organize their photo collections. In Organize mode, users can choose to view photos by Date, Calendar, All Photos, Tags, Collections, or Saved Searches.

Downloading photos and videos from a camera

With the Corel Photo Downloader, it couldn’t be simpler. Just plug in a camera or memory card, and the Photo Downloader takes care of the rest. When the Photo Downloader finishes, the downloaded photos display in the Corel MediaOne organizer. For added convenience, users can also set options so that the Photo Downloader downloads automatically, rotates photos automatically, or clears memory card space by deleting photos that have been downloaded.

Viewing, editing, and organizing photos and videos in full-screen mode

When the Corel Photo Downloader finishes, the Quick Review starts automatically. This full-screen slide show lets users view all photos that have just been downloaded. Users can stop the slide show to add tags, star ratings, captions, and comments to their photos. During Quick Review, users can also delete photos, apply quick fixes, and copy photos to the photo tray for future use.
Tagging photos

Tags help users categorize and organize their photo collections. For example, users can add “Daughter’s birthday” to all of the photos taken during the occasion. Then, the tag can be used to quickly and easily find those specific photos. Corel MediaOne makes it easy to add tags to photos.

Give it a try

To add tags to photos

1. In the Home panel, select Organize, click the plus sign (+) next to Tags, and double-click Add Tags.

2. In the Add Tag dialog box, type the tag name in the Tag field, and click OK.

3. Drag the new tag name from the Home panel onto a photo.

4. Click View > Photo Information to open the General Info panel, which displays the newly added tag in the Tags area.
Finding specific photos and videos

If users apply text (as tags or captions) to help identify their photos, the **Find Photos** command will find those photos instantly. Users simply enter text in the upper-right corner of the application or click on the Find Photos button to perform an advanced search.

Organizing photos into specific collections

With the introduction of **Smart Collections**, Corel MediaOne continues to make it easier for users to find their favorite photos. While talking with customers, Corel found that some users were having difficulty finding specific photos. To solve this problem, the preset Smart Collections gather photos into specific groups. For example, Smart Collections can be used to instantly view all photos created in 2007. In addition, users can create their own Smart Collections — for example, “Daughter’s fifth birthday” — to better organize their photos.

Editing and Enhancing Photos and Videos

With Corel MediaOne, it’s fun and easy for users to enhance their favorite photos. Users can get started immediately by choosing from simple, one-click features. The application also includes the Photo Doctor, which is perfect for new digital camera owners or novice software users who may not know how to improve their photos.

**Photo Doctor**

In talking with customers, Corel found that many users were unsure of when to use Quick Fix and were unaware of its benefits. To solve this problem, Corel MediaOne includes the unique **Photo Doctor**. This feature analyzes each photo as it is opened and displays a special icon if Quick Fix may significantly improve the photo — helping to ensure that more of our users photos look their best.

Quick Fix

Users can apply the **Quick Fix** command in a single click to automatically adjust a photo’s color balance, contrast, clarity, and saturation.
Cropping
Users can instantly focus the attention of a photo and eliminate background distractions by using the Crop tool, which works similarly to a camera’s zoom except that the photo has already been taken. This handy tool also lets users instantly crop to standard photo sizes as well as experiment with freeform options.

Removing red-eye
With Corel MediaOne, users can quickly and easily correct red-eye in their photos. Users simply adjust the tool size to suit the size of the area they want to correct, and then click on that area.

Applying an effect
Corel MediaOne Plus includes simple effects that let users give their photos a vintage look. With just one click, users can transform color photos into black-and-white, or sepia tones. Corel MediaOne Starter is limited to black-and-white.

Straightening (Corel® MediaOne™ Plus feature)
Corel MediaOne Plus includes the Straighten tool, which lets users quickly align crooked photos and automatically crop the edges.

Give it a try
To use the Straighten tool
1. In Organize mode, double-click the thumbnail of a photo, or click File ➤ Open ➤ Photo.
Using the Makeover tools
(Corel® MediaOne™ Plus feature)

With the incredible Makeover tools, Corel MediaOne puts the power of professional retouching in the hands of users. These powerful tools make it easy to touch-up the people in photos, letting everyone put their best face forward. With three professional-strength modes, users can remove any blemish, brighten any smile, or add a touch of sun to any complexion:

• **Blemish Fixer mode** – Simply adjust the tool size and then click to remove blemishes.

  ![Before](image1) ![After](image2)

• **Toothbrush mode** – Just click anywhere on teeth to brighten and accentuate the smile.

  ![Before](image3) ![After](image4)

• **Suntan mode** – Brush on color to warm-up pale complexions.

  ![Before](image5) ![After](image6)

---

**Give it a try**

1. On the Enhance panel, click the **Straighten** tool. A straightening bar with end handles appears on the photo.
2. Drag each end handle of the straightening bar to align it with a vertical or horizontal line, such as a horizon or telephone pole.
3. Double-click in the image area to straighten the photo, or in the Straighten dialog box, click **Apply**.
**Give it a try**

**To use the Makeover tools**

1. In Organize mode, double-click the thumbnail of a photo with a person whose look you want to touch up, or click **File > Open > Photo**.

2. On the Home panel, click **Enhance > Adjust Photo**, and then click **Makeover**.

3. Choose one of the following Makeover tool modes:
   - **Blemish Fixer**
   - **Toothbrush**
   - **Suntan**

4. On the Makeover palette, make any necessary adjustments to the values in the **Size** and **Strength** boxes.

5. Click in the appropriate area of the photo.

**Adding a frame to a photo**  
(Corel® MediaOne™ Plus feature)

To help users make their photos stand out, Corel MediaOne Plus includes dozens of new **frames** and **edges**. Users can easily add personalized, finishing touches to their photos by choosing from an array of unique picture frames and photo edge effects.

![Corel MediaOne Plus includes dozens of new frames and edges.](image)

![Before After](image)
Embellishing photos with Picture Tubes™
(Corel® MediaOne™ Plus feature)

Corel MediaOne Plus includes dozens of new Picture Tubes™. This collection of professionally-designed artistic elements lets user add extra personality to their photos. For example, users can add butterflies to a picnic setting, or frame a picture with flowers. Picture Tubes are especially popular with users who are interested in scrapbooking. Corel MediaOne Plus provides a variety of Picture Tube themes, including Animals, Artistic, Embellishments, Nature, Photo Objects, and Plants and Leaves.

Corel MediaOne Plus includes dozens of new Picture Tubes™, which can be used to embellish photos.

Advanced editing with Corel® Paint Shop Pro® Photo

If users have Corel® Paint Shop Pro® Photo installed, Corel MediaOne will let them easily switch between the applications. With a single click, users can jump from Corel MediaOne into Paint Shop Pro for more advanced photo editing.

Editing Videos

With Corel MediaOne, users can edit videos, including extracting specific frames. Corel MediaOne Plus gives users more advanced video-editing features.

Editing a video
(Corel® MediaOne™ Plus feature)

With Corel Shows, users can do more with the videos taken with their digital cameras, including trimming video clips and extracting specific frames. Users can
also save their Corel Shows as movie files in a variety of sizes suitable for sharing on the Web, on DVD, or even on HDTV.

Corel MediaOne Plus makes it easy to preview, trim, and extract still frames from videos.

### Give it a try

**To trim a video**

1. In the Home panel, click **Organize**, click the plus sign (+) next to **Folders**, and select a folder that contains a video file.
2. Drag the thumbnail of the video onto a photo tray.
3. In the Home panel, click **Show**, and drag the video's thumbnail from the photo tray onto the Storyboard.
4. In the Storyboard, click the video's thumbnail to select it. Directly above the Storyboard, **Set Start** and **Set End** handles appear with the standard video controls.
5. To set the start point, drag the **Set Start** handle to the right.
6. To set the end point, drag the **Set End** handle to the left.

### Extracting a frame from a video

Corel MediaOne lets users extract a frame from a video file and save it as a photo. When playing a video file, users can simply press the Pause button when they reach the frame that they want to extract, and then use the convenient on-screen controls to save the frame.

### Creating Projects with Photos and Videos

Corel MediaOne makes it easy for users to do more with their photos than they ever thought possible. In just minutes, users can make visually stunning photo creations simply by dragging their photos onto professionally designed templates. Users can choose from album pages, calendars, collages, greeting cards, and more. For easy sharing, users can print their photo projects or e-mail them to friends and family.
Organizing photos into photo trays

Corel MediaOne includes photo trays that let users gather photos from various folders. From a photo tray, users can e-mail or print their photos, create a photo project, or upload their photos to a photo-sharing service. Users can also add, remove, and rename photo trays.

Photo trays make it easy to organize photos for sharing with others.

Making a Corel® Show

It’s easy to create an entertaining Corel Show that’s sure to impress friends and family. Corel MediaOne Plus users can enliven a Corel Show by adding their own music (in WAV, MP3, or WMA format), cool transitions, and fun motion effects that zoom in and across the photos. Users can choose between automatic motion effects, or they can manually choose the start and end points for each motion effect. Users of both Corel MediaOne Plus and Corel MediaOne Starter can also add their own captions to each slide. It’s also simple to add video clips taken with a digital camera to a Corel Show. What’s more, Corel MediaOne integrates with muvee® autoProducer™ to give users additional options and flexibility for creating stunning video productions.

With Corel Shows, users can easily add exciting motion effects to their slide shows.

Give it a try

To make a Corel Show

1. In the Home panel, drag the photos you want to use for your Corel Show onto a photo tray, and then click Show.

2. Drag photos from the photo tray onto the Storyboard.

3. To adjust individual slide settings, add motion effects or transitions, select a slide from the Storyboard, and click Adjust Settings ➔ Change Slide Settings in the left panel.
Using project templates

Corel MediaOne includes hundreds of creative templates designed to inspire users to do more with their photos. Corel MediaOne Plus users benefit from the addition of dozens of new templates from Smilebox and Sandra Magsamen.

Corel MediaOne Plus includes dozens of new project templates from Smilebox and Sandra Magsamen.

With drag-and-drop simplicity, users can easily create stunning album pages, greeting cards, calendars, and collages. Within each project category, users can choose from a variety of different layouts. In addition, users can customize their projects by adding text, adjusting the position of photos, panning and zooming, or creating multiple pages.

An array of professionally designed templates makes it easy to create photo projects.
**Give it a try**

<table>
<thead>
<tr>
<th>To use project templates</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 In Organize mode, drag the photos for your project into a photo tray.</td>
</tr>
<tr>
<td>2 On the Home panel, click <strong>Create</strong>.</td>
</tr>
<tr>
<td>3 On the Choose a Project page, click one of the available project categories.</td>
</tr>
<tr>
<td>4 On the Home panel, click <strong>Adjust Layout &gt; Select Layout</strong> to choose a layout for your project.</td>
</tr>
<tr>
<td>5 In the Select Layout dialog box, choose a category from the <strong>Style</strong> list box, and choose a template from the <strong>Layout</strong> list.</td>
</tr>
<tr>
<td>6 On the Project page, drag photos from the photo tray onto the cells of the layout.</td>
</tr>
<tr>
<td>7 In the Position Photos dialog box, arrange photos in the cells by selecting a cell and using any of the following options or controls:</td>
</tr>
<tr>
<td>• <strong>Fill Frame</strong> — enlarges the photo to fill the cell</td>
</tr>
<tr>
<td>• <strong>Fit to Frame</strong> — fits the entire photo in the cell</td>
</tr>
<tr>
<td>• <strong>Rotate Right</strong> or <strong>Rotate Left</strong> buttons — changes the photo orientation</td>
</tr>
<tr>
<td>• <strong>Zoom Tool</strong> — increases or decreases the size of the photo in the cell</td>
</tr>
<tr>
<td>• <strong>Pan Tool</strong> — moves the photo in the cell to show hidden areas</td>
</tr>
<tr>
<td>8 To add text, click in the <strong>Click to Add Text</strong> field, and use the controls in the Add/Edit Text dialog box to format your text.</td>
</tr>
<tr>
<td>9 In the Add/Edit text dialog box, click in the <strong>Text</strong> field, press <strong>Delete</strong> and type your text. You can use the controls in the Add/Edit text dialog box to format your text.</td>
</tr>
</tbody>
</table>

---

### Sharing Photos and Videos

From e-mailing and printing to creating CDs or DVDs, Corel MediaOne makes it easy for users to share their photos.

#### Printing Photos

The Quick Print feature lets users choose from a variety of automatic layouts, such as 4 x 6 inch, 5 x 7 inch, 8 x 10 inch, wallet-size, and many more.

#### Viewing on a computer or high-definition television

Corel MediaOne users can view Corel Shows at video resolutions appropriate for display on HD televisions and monitors. Users can easily change Quick Review settings for the appropriate display output.

#### E-mailing photos, shows, and videos

For fast and flexible e-mail options, nothing beats Corel MediaOne. For a fun and entertaining way to share multiple photos, users can e-mail a Corel Show. Users can also embed photos in the body of an e-mail to ensure that recipients can immediately view their photos. For the highest level of compatibility, users can also attach photos to an e-mail.
Corel MediaOne provides fast and flexible e-mail options for sharing photos and slide shows.

Uploading photos to an online print service

Corel MediaOne includes support for popular photo-sharing Web sites. Users can easily order prints for pickup from local print services vendors, or for mail delivery through online services.

Making a video of a Corel® Show (Corel® MediaOne™ Plus feature)

With Corel MediaOne Plus, users can save their Corel Shows as videos at resolutions suitable for VHS, DVD, and HDTV.

Give it a try

To save a Corel Show as a video

1. In the Home panel, click Organize, and select a folder that contains the Corel Show that you want to save as a video.

2. In Organize mode, right-click the thumbnail of the Corel Show and choose Preferences from the drop-list.

3. In the Multimedia area of the Preferences dialog box, choose one of the following options from the Video Output Size list box:
   - Web/VHS (320 × 240)
   - DVD (640 × 480)
   - HD (1280 × 720)
   - HD (1920 × 1080)

4. Click OK, and then double-click the thumbnail of the Corel Show.

5. In the Home panel, click Show > Save, and choose Save As Video.

6. In the File name box, type a name for your video, and click Save.

Making a DVD of a Corel® Show or video (Corel® MediaOne™ Plus feature)

If users have a DVD burner, they can create DVDs of slide shows and videos with Corel MediaOne Plus. There are dozens of creative DVD menu backgrounds. Users can even include a menu soundtrack.
Users can easily add a DVD menu and soundtrack to a DVD.

Give it a try

To make a DVD of a Corel Show or video

1. In the Home panel, click **Organize**, click the **plus sign** (+) next to **Folders**, and select a folder that contains either a Corel Show or video.

2. Double-click the Corel Show or video that you want to burn to DVD.

3. In the Show panel, click **Share**, and click **Create a DVD** to open the Create a DVD dialog box.

4. To add a menu soundtrack, click the **DVD Menus** tab, and in the **Menu Soundtrack** area, click **Add**. Use the Choose Menu Soundtrack dialog box to select the WAV, MP3, or WMA music file you want to use, and click **Open**.

5. In the **Menu Background** area, select one of the available DVD menu backgrounds, and click **Create DVD**.

Making a CD of photos

(***Corel® MediaOne™ Plus feature**)

For maximum portability, Corel MediaOne Plus also lets users burn selected photos to CD or DVD. The **Quick Disc** feature is perfect for sharing photos with friends and family, or for taking photos to a store to order prints.

Protecting Photos and Videos

Corel MediaOne takes the effort out of backing up a digital photo collection. Without requiring additional burning software, Corel MediaOne lets users back up their entire digital photo collection.

Backing up photos online with a Sharpcast account

To protect photos from a hard-disk failure, users can sign up for a free **Sharpcast** account. With the basic plan, this seamless and easy-to-use online storage solution backs up photos in JPEG format. In the event of computer failure, or if photos on a user’s computer become damaged, the user can access their Sharpcast account to quickly restore their photos. After the initial back up, each
time the user plugs in their camera and uses the Corel Photo Downloader, the downloaded photos are automatically backed up by Sharpcast.

For the first 30 days after signing up with Sharpcast, users receive unlimited back up and recovery of their JPEG photos at full resolution. After 30 days, photos are resized to 4 × 6 inches (2 megapixels) for long-term storage. With an upgrade to one of Sharpcast’s Premium Plans, the users’ photos remain at their full resolution for the duration of the plan. Users can also back up other file types, such as videos and Corel Shows, provided they don’t exceed the maximum storage quota that their premium plan allows.

A Sharpcast account lets users safeguard their photos.

**Give it a try**

**To back up photos online**

1. In the Home panel, choose **Protect**, and click **Back Up Online**.
2. In the Back Up Online dialog box, click **OK**.

All JPEG photos from the My Pictures folder are backed up online.

**Restoring photos**

If computer failure or another event damages photos, users can quickly and easily restore their folders and photos to their computer from the online storage space associated with their Sharpcast account.

**Sharing photos online with Sharpcast**

After using the Sharpcast online back-up service, users photos will appear in an online gallery that they can share with friends and family.

**Give it a try**

**To share photos online**

- In the **Home** panel, click **Share** > **View Photos Online**.
Upgrading a Sharpcast Plan

It's easy for Corel MediaOne users to upgrade their Sharpcast Plan for more storage space.

Give it a try

To upgrade a Sharpcast Plan

1. In the Home panel, choose Protect, and click Back Up Online.
2. In the Back Up Online dialog box, click Change Plan.
   Your Web browser will open and display the Sharpcast – My Account page.
   A list of available plans will be displayed.

Back up photos and videos to CD or DVD
(Corel® MediaOne™ Plus feature)

With Corel MediaOne, it’s never been easier to preserve and protect digital photos on a CD or DVD. With just two clicks, the PhotoSafe Backup system prevents the loss of users’ precious digital images.

Give it a try

To back up photos to CD or DVD

1. With a blank CD or DVD in your burner, select Protect from the Home panel, and click Back Up to Disc.
2. In the PhotoSafe Backup dialog box, choose one of the following options:
   - All photos not yet backed up — backs up only the cataloged photos that have not yet been backed up. This option is recommended if you have previously backed up some photos.
   - All photos — backs up all photos, including previously backed up photos
3. In the Disc label field, type a label of up to 14 characters.
4. Click Burn.
What’s Included?

Corel® MediaOne™ Versions

- **Corel® MediaOne™ Starter**: This free download provides everything you need to easily organize, enhance, share, and protect your digital photos. It includes a 30-day preview of the advanced photo- and video-editing features offered by Corel MediaOne Plus. With a minimum of clicks, users can apply photo fixes, as well as create photo projects and slide shows that are perfect for sharing with friends and family.

- **Corel® MediaOne™ Plus**: The premium edition of Corel MediaOne includes all the basic organization and sharing options of Corel MediaOne Starter, as well as more advanced, yet easy-to-use, photo- and video-editing features. Corel MediaOne Plus also provides more options for creating unique slide shows, advanced video-editing features, and additional project templates.

System Requirements

- 1-GHz processor (2-GHz processor or faster recommended)
- Windows Vista™ (with latest service pack) or Windows® XP (with SP2)
- 256 MB of RAM (512 MB of RAM or greater recommended)
- 500 MB of free hard-disk space
- 1024 × 768 resolution display, 24-bit color display
- DirectX® 9
- QuickTime® 7 or later version
- CD drive (recordable CD or DVD drive recommended)
- Mouse or tablet
- Internet Explorer®
- Outlook®, Outlook Express, WordPerfect® MAIL™, or other MAPI-compliant e-mail software (to e-mail from the product)
Customer Support and Other Resources

Corel provides support options for our consumer, small business, and corporate customers. Additional information about global availability of our support services is located on the Corel Web site at www.corel.com/support.

Free support

Available 24 hours a day, 7 days a week, the Corel Knowledge Base provides free unlimited support for all registered users of Corel’s retail and licensed software. This searchable Web-based tool provides answers to commonly asked technical questions. Responses are searchable in seven languages, including English, French, German, Italian, Spanish, Portuguese, and Japanese. To search the Corel Knowledge Base, please visit www.corel.com/knowledgebase.

Warranty support

Corel’s Warranty Support consists of one courtesy telephone support call and unlimited Web-based electronic support.

Zoom-In newsletter

A must-have for digital camera owners, this free monthly newsletter provides tutorials, quick tips, links to free content downloads, and user profiles that illustrate how people just like you are using Corel digital imaging software to create and share their favorite photos.

The free Zoom-In newsletter is a valuable resource for digital camera owners.

Customer Care

Corel offers a toll-free line for general assistance and sales inquiries. We are always interested in your reactions to our software, so please tell us what you think about Corel MediaOne. You can contact us at feedback@corel.com.
Corel® MediaOne™ Version Comparison

<table>
<thead>
<tr>
<th>Photo Editing</th>
<th>Corel® MediaOne™ Starter</th>
<th>Corel® MediaOne™ Plus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotate Photos</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Resize Photos</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Crop Photos to Preset Sizes</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Automatically Identify Problem Photos (Photo Doctor)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>One-Click Photo Fix (Quick Fix)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Manually Adjust Photos (Photo Fix)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Remove Red-eye</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Straighten Photos 30-Day Preview</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Whiten Teeth 30-Day Preview</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Paint on a Suntan 30-Day Preview</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Remove Blemishes 30-Day Preview</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Convert Photos to Black-and-White</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Convert Photos to Sepia 30-Day Preview</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Add Stylish Text 30-Day Preview</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Add Frames and Edges 30-Day Preview</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Add Picture Tubes™ 30-Day Preview</td>
<td></td>
<td>✓</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Video Editing and Multimedia Shows</th>
<th>Corel® MediaOne™ Starter</th>
<th>Corel® MediaOne™ Plus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download and View Video Clips</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Extract Still Frames from Video Clips</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Trim Video Clips 30-Day Preview</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Save Multimedia Shows as Video Files</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Optimize Video Files for Web, DVD, or HDTV</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Compatible with muvee® autoProducer™</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Feature</td>
<td>Corel® MediaOne™ Starter</td>
<td>Corel® MediaOne™ Plus</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Mix Photos, Music, and Video in Corel Shows</td>
<td>Photos and Video Only</td>
<td>✓</td>
</tr>
<tr>
<td>Add Pan and Zoom Effects to Multimedia Shows</td>
<td>30-Day Preview</td>
<td>✓</td>
</tr>
<tr>
<td>Add Transitions to Multimedia Shows</td>
<td>Limited</td>
<td>Enhanced</td>
</tr>
<tr>
<td><strong>Creative Projects</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Album Pages and Greeting Cards</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Create Calendars and Collages</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Create Certificates and Magazine Covers</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Artful Memory Scrapbooks</td>
<td>30-Day Preview</td>
<td>✓</td>
</tr>
<tr>
<td>Smilebox Digital Scrapbooks</td>
<td>30-Day Preview</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Sharing</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E-mail Photos</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Share Multimedia Shows as Corel Shows</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Share Online Galleries</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Print Photo Layouts</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Make a Picture CD</td>
<td>30-Day Preview</td>
<td>✓</td>
</tr>
<tr>
<td>Order Photo Prints Online</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Make a DVD of Multimedia Shows and Videos</td>
<td>30-Day Preview</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Photo Protection</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Backup Photo Library to CDs and DVDs</td>
<td>30-Day Preview</td>
<td>✓</td>
</tr>
<tr>
<td>Backup Photo Library Online</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
About Corel Corporation

Corel is a leading developer of graphics, productivity, and digital media software, with more than 100 million users worldwide. The company’s product portfolio includes some of the world’s most popular and widely recognized software brands, including CorelDRAW® Graphics Suite, Corel® Paint Shop Pro®, Corel® Painter™, Corel DESIGNER®, Corel® WordPerfect® Office, WinZip®, and iGrafx®. In 2006, Corel acquired InterVideo, makers of WinDVD®, and Ulead, a leading developer of video, imaging, and DVD authoring software. Designed to help people become more productive and express their creative potential, Corel’s full-featured software products set a higher standard for value in being easier to learn and use. The industry has responded with hundreds of awards recognizing Corel’s leadership in software innovation, design, and value. Corel’s products are sold in more than 75 countries through a well-established network of international resellers, retailers, original equipment manufacturers, online providers, and Corel’s global Web sites. With its headquarters in Ottawa, Canada, the company has major offices in the United States, the United Kingdom, Germany, China, and Japan. Corel’s stock is traded on the NASDAQ under the symbol CREL and on the TSX under the symbol CRE.